
http://www.facebook.com/share.php?u=http://www.quepublishing.com/title/9780789749369
http://twitter.com/?status=RT: download a free sample chapter http://www.quepublishing.com/title/9780789749369
https://plusone.google.com/share?url=http://www.quepublishing.com/title/9780789749369
http://www.linkedin.com/shareArticle?mini=true&url=http://www.quepublishing.com/title/9780789749369
http://www.stumbleupon.com/submit?url=http://www.quepublishing.com/title/9780789749369/Free-Sample-Chapter


Adobe®

Edge Animate
onDemand

Steve Johnson, Perspection, Inc.

Que Publishing, 800 East 96th Street, Indianapolis, IN 46240 USA



Adobe® Edge Animate on Demand

Copyright © 2013 by Perspection, Inc.

All rights reserved. No part of this book shall be reproduced, stored in a
retrieval system, or transmitted by any means, electronic, mechanical, photo-
copying, recording, or otherwise, without written permission from the publish-
er. No patent liability is assumed with respect to the use of the information
contained herein. Although every precaution has been taken in the prepara-
tion of this book, the publisher and author assume no responsibility for errors
or omissions. Nor is any liability assumed for damages resulting from the use
of the information contained herein.

Library of Congress Cataloging-in-Publication Data is on file

ISBN-13: 978-0-7897-4936-9

ISBN-10: 0-7897-4936-X

Printed and bound in the United States of America
First Printing: December 2012

15  14  13  12             4  3  2  1  

Que Publishing offers excellent discounts on this book when ordered 
in quantity for bulk purchases or special sales. 

For information, please contact: U.S. Corporate and Government Sales

1-800-382-3419 or corpsales@pearsontechgroup.com

For sales outside the U.S., please contact: International Sales

1-317-428-3341 or International@pearsontechgroup.com

Trademarks
All terms mentioned in this book that are known to be trademarks or service
marks have been appropriately capitalized. Que cannot attest to the accuracy
of this information. Use of a term in this book should not be regarded as
affecting the validity of any trademark or service mark. 

Adobe, the Adobe logo, Acrobat, After Effects, AIR, Audition, Bridge, Connect,
Captivate, Device Central, Dreamweaver, Edge Animate, Edge Code, Edge
Inspect, Edge Reflow, Edge Web Fonts, Extension Manager, Fireworks, Flash,
Flash Builder, InCopy, InDesign, Illustrator, Muse, OnLocation, Premiere Pro,
Photoshop, Photoshop Elements, SoundBooth, and Typekit are registered
trademarks of Adobe System Incorporated. 

Warning and Disclaimer
Every effort has been made to make this book as complete and as accurate as
possible, but no warranty or fitness is implied. The authors and the publishers
shall have neither liability nor responsibility to any person or entity with
respect to any loss or damage arising from the information contained in this
book.

Publisher
Paul Boger

Associate Publisher
Greg Wiegand

Acquisitions Editor
Laura Norman

Managing Editor
Steve Johnson

Author
Steve Johnson

Page Layout
James Teyler

Interior Designers
Steve Johnson
Marian Hartsough

Indexer
Kristina Zeller

Proofreader
Beth Teyler

Team Coordinator
Cindy Teeters



iii

Acknowledgments

a

a
Perspection, Inc.
Adobe Edge Animate on Demand has been created by the professional trainers and
writers at Perspection, Inc. to the standards you’ve come to expect from Que pub-
lishing. Together, we are pleased to present this training book.

Perspection, Inc. is a software training company committed to providing information
and training to help people use software more effectively in order to communicate,
make decisions, and solve problems. Perspection writes and produces software
training books, and develops multimedia and web-based training. Since 1991, we
have written more than 120 computer books, with several bestsellers to our credit,
and sold over 5 million books. 

This book incorporates Perspection’s training expertise to ensure that you’ll receive
the maximum return on your time. You’ll focus on the tasks and skills that increase
productivity while working at your own pace and convenience.

We invite you to visit the Perspection web site at:

www.perspection.com

Acknowledgments
The task of creating any book requires the talents of many hard-working people
pulling together to meet impossible deadlines and untold stresses. We’d like to
thank the outstanding team responsible for making this book possible: the writer,
Steve Johnson; the production editor, James Teyler; proofreader, Beth Teyler; and
the indexer, Kristina Zeller. 

At Que publishing, we’d like to thank Greg Wiegand and Laura Norman for the
opportunity to undertake this project, Cindy Teeters for administrative support, and
Sandra Schroeder for your production expertise and support.

Perspection

http://www.perspection.com


iv

aa

About the Author
Steve Johnson has written more than 80 books on a variety of computer software,
including Adobe Photoshop CS6, Adobe Dreamweaver CS6, Adobe InDesign CS6,
Adobe Illustrator CS6, Adobe Flash Professional CS5, Microsoft Windows 8,
Microsoft Office 2010 and 2007, Microsoft Office 2008 for the Macintosh, and Apple
OS X Mountain Lion. In 1991, after working for Apple Computer and Microsoft,
Steve founded Perspection, Inc., which writes and produces software training. When
he is not staying up late writing, he enjoys coaching baseball, playing golf, garden-
ing, and spending time with his wife, Holly, and three children, JP, Brett, and Han-
nah. Steve and his family live in Northern California, but can also be found visiting
family all over the western United States.



Acknowledgements v

a

We Want to Hear from You!
As the reader of this book, you are our most important critic and commentator. We
value your opinion and want to know what we’re doing right, what we could do bet-
ter, what areas you’d like to see us publish in, and any other words of 
wisdom you’re willing to pass our way. 

As an associate publisher for Que, I welcome your comments. You can email or
write me directly to let me know what you did or didn’t like about this book—as well
as what we can do to make our books better.

Please note that I cannot help you with technical problems related to the topic 
of this book. We do have a User Services group, however, where I will forward spe-
cific technical questions related to the book.

When you write, please be sure to include this book’s title and author as well as
your name, email address, and phone number. I will carefully review your com-
ments and share them with the author and editors who worked on the book.

Email: feedback@quepublishing.com

Mail: Greg Wiegand
Que Publishing
800 East 96th Street
Indianapolis, IN 46240 USA

For more information about this book or another Que title, visit our web site at
www.quepublishing.com. Type the ISBN (excluding hyphens) or the title of a book in
the Search field to find the page you’re looking for.

http://www.quepublishing.com


This page intentionally left blank 



vii

Contents

c

c
Introduction xiii

Getting Started with Edge Animate 1

Finding Out What You Can Do with Edge Animate 2
Exploring Edge Animate and Edge Tools 3
Starting Edge Animate 4
Using the Welcome Screen 6
Viewing the Edge Animate Window 8
Preparing for a Project 9
Creating a Project Plan 10
Building an Edge Animate Project 12
Creating a New Animation 14
Getting Sample Animations 15
Opening an Existing Animation 16
Working with Multiple Animations 18
Previewing an Animation in a Browser 19
Saving an Animation 20
Getting Online Support 22
Finishing Up 24

Working Within the Edge Animate Window 25

Examining the Edge Animate Window 26
Changing Stage Properties 28
Working with the Stage 30
Changing the Stage View 31
Using the Tools Panel 32
Using the Properties Panel 34
Using the Elements Panel 36
Using the Library Panel 38
Using the Timeline Panel 40
Working with Timeline Panel Controls 42
Using the Code Panel 44
Working with Panels 46

2

1



viii

c

Docking and Undocking Panels 48
Creating and Using Workspaces 50
Defining Keyboard Shortcuts 52
Changing the Language 54
Undoing or Redoing Changes 55

Taking In�App Lessons 57

Starting a Lesson 58
Using the Lessons Panel 60
Taking the Quick Start Lesson 61
Taking the Create Lesson 62
Taking the Animate with Keyframes Lesson 64
Taking the Animate with the Pin Lesson 68
Taking the Resize Lesson 70
Taking the Extend Lesson 74
Taking the Reuse Lesson 78

Working with Shapes and Graphics 81

Understanding Vector and Bitmap Graphics 82
Gathering and Using Graphics 83
Examining Import Graphic Formats 84
Importing Graphics 85
Adding Graphics 86
Drawing Shapes 88
Using Smart Guides with Elements 90
Selecting Elements 92
Naming Element IDs or Classes 94
Changing Element Tags 95
Changing Element Display 96
Changing Element Overflow 97
Changing Element Opacity 98
Changing Element Position 99
Changing Element Size 100
Changing Element Adjustability 101
Changing Shape Corners 102
Changing Shape Borders 104
Changing Shape Background Color 106
Adding Shadows to Elements 107
Changing Cursors Over Elements 108
Modifying Image Elements 109
Transforming Element Origin 110

4

3



Contents ix

c

Rotating Elements 112
Skewing Elements 114
Scaling Elements 116
Changing Element Clipping 118
Adding Accessibility to Elements 120

Working with Text 121

Creating Text Boxes  122
Adding Text 123
Editing Text 124
Dictating Text 125
Inserting Special Characters 126
Examining Text Properties 127
Changing Text Properties 128
Getting Web Fonts 130
Adding Web Fonts 132
Resizing Text Boxes 134
Clipping Text 135
Transforming Text 136
Adding Shadows to Text 138
Changing Text Tag 139
Adding Links to Text 140

Working with Symbols and Elements 143

Creating Symbols 144
Importing Symbols 145
Exporting Symbols 146
Creating an Instance from a Symbol 147
Modifying an Instance from a Symbol 148
Editing Symbols 150
Nesting Symbols within Symbols 152
Copying or Duplicating Elements 154
Deleting Elements 156
Displaying Rulers 158
Displaying Guides 159
Using Guides with Elements 160
Aligning and Distributing Elements 162
Stacking Elements 164
Hiding and Showing Elements 165
Grouping Elements 166
Reparenting Elements 167

6

5



x

c

Locking and Unlocking Elements 168
Renaming Elements 169

Creating Motion Animations 171

Creating an Animation with the Pin 172 PrEx

Creating an Animation with Auto Keyframes 174 PrEx

Creating an Animation with Keyframes 176 PrEx

Creating an Animation with a Transition 178
Playing Animations 180
Making Adjustments to Animations 182
Adjusting Time in an Animation 184
Inserting Time in an Animation 185
Making a Resizable Animation 186 PrEx

Testing a Resizable Animation 190

Creating Interactive Animation 193

Inserting Labels 194
Inserting and Editing Triggers 196
Inserting and Editing Action Events 198
Listing of Action Events 200
Inserting Code Snippets 202
Listing of Code Snippets 203
Working with JavaScript Code 204
Using Show and Hide Element Snippets 206
Using Element Text Snippets 208
Using the Open URL Snippet 210
Using Get Symbol Snippets 212
Using Create and Delete Symbol Snippets 214
Creating a Rollover Button 216 PrEx

Creating a Shopping Cart Button 218 PrEx

Embedding and Playing a Video 220 PrEx

Adding and Playing a Sound 221 PrEx

Swapping Images in a Photo Gallery 222 PrEx

Publishing Animations 223

Publishing Considerations 224
Publishing a Composition 225
Publishing for the Web 226
Publishing to the Web for IE 6, 7, and 8 227
Publishing to the Web Using CDN 228
Publishing to the Web as Static HTML 229

9

8

7



Contents xi

c

Publishing for Adobe Programs 230
Publishing for iBooks Author 232
Capturing a Poster Image 234
Creating a Down-level Stage 236
Creating a Preloader Stage 238

Working with HTML, CSS, and JavaScript 241

Examining Edge Animate Files 242
Viewing the Code Behind the Scenes 244
Examining the Adobe Edge Animate Runtime 246
Getting to Know HTML 248
Working with HTML 250
Getting to Know CSS 252
Working with CSS 254
Putting a Composition in an HTML Document 256
Adding an Animation to an HTML Document 258

Working Together with Adobe Programs 259

Opening Compositions in Adobe Dreamweaver 260
Importing into Adobe Muse 262
Importing into Adobe InDesign 264
Working with Adobe Digital Publishing Suite 266
Saving Images from Adobe Photoshop 268
Saving Graphics from Adobe Fireworks 270
Exporting Images from Adobe Illustrator 272
Saving Artwork from Adobe Illustrator 274
Exporting Animations from Adobe Flash 276

Installing Edge Animate and Edge Tools 279

Preparing for Edge Animate and Tools 280
Downloading Edge Animate and Tools 282
Installing Edge Animate and Tools 284
Finishing the Edge Inspect Install 286

Keyboard Shortcuts 289
Menu by Menu 293
Index 301

A

11

10



This page intentionally left blank 



xiii

Introduction

Welcome to Adobe Edge Animate on Demand, a visual quick
reference book that shows you how to work efficiently with
Edge Animate.  This book provides complete coverage of
basic to advanced Edge Animate skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
Adobe Edge Animate 1.0 is the debut version of the product,
so everything in the product is New!You can look forward to
many more new features in the next version of the product.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
Ctrl+I (Win) or A+I (Mac), as a quicker alternative to using
the mouse. A complete list of keyboard shortcuts is available
in the back of this book.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Project Examples

Workshops

Get More on the Web
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ple files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a sample file to
see how a feature works and
apply what you have learned. Not
every topic needs an example file,
such as changing options. The
example files that you need for
project tasks are available on the
web at www.queondemand.com
or www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.

http://www.queondemand.com
http://www.perspection.com


The Project
Examples walk
you through tasks
to help you put
Edge Animate to
work.

Introduction xv

Project Examples
For some topics, this book includes
project examples that provide step-
by-step tasks with specific end
results. They are like mini-work-
shops. You start each project with a
sample file, work through the
steps, and then compare your
results with a project results file at
the end. The project example files
are available on the web at
www.queondemand.com or
www.perspection.com. Look for
the icon: PrEx. The icon appears in
the table of contents so you can
quickly and easily identify them. 

Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshops. You start each
project with a sample file, work
through the steps, and then com-
pare with a results file at the end.
The Workshops and associated
files are available on the web at
www.queondemand.com or
www.perspection.com. The Workshops

walk you through
in-depth projects
to help you put
Edge Animate to
work.

http://www.queondemand.com
http://www.perspection.com
http://www.queondemand.com
http://www.perspection.com
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Get More on the Web
In addition to the information in
this book, you can also get more
information on the web to help
you get up-to-speed faster with
Edge Animate. Some of the infor-
mation includes: 

Productivity Tools
◆ Keyboard Shortcuts.

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. 

More Content
◆ More Content. Download

new content developed after
publication.

You can access these additional
resources on the web at
www.queondemand.com or
www.perspection.com.

Additional
content
is available
on the web. 

http://www.queondemand.com
http://www.perspection.com


Taking In-App Lessons

Introduction

From the Welcome screen or the Lessons panel, you can use
In-App Lessons to help you get started with the project in
Edge Animate. The In-App Lessons provide seven step-by
step topics with the aid of the Lessons panel to walk you
through the process of creating animations with Edge
Animate. The lessons include Quick Start to help you get
going, Create to teach you how to work with shapes, text and
images, Animate I: Keyframes and II: The Pin to show you
how to use keyframes and pins, Resize to learn how to
respond to size changes, Extend to learn how to loop and
handle user interaction, and Reuse to show you how to cre-
ate reusable elements with symbols. 

If you want further help and instructional materials, you
can use links in the Welcome screen to access a list of key
features and product release notes, and helpful resources
from online content, including Help and Tutorials, videos on
Adobe TV, community forums, and sample projects. In addi-
tion, you can access Facebook and Twitter to get more infor-
mation about Edge Animate. 3

3
What You’ll Do

Start a Lesson

Use the Lessons Panel

Take the Quick Start Lesson

Take the Create Lesson

Take the Animate with Keyframes
Lesson

Take the Animate with the Pin Lesson

Take the Resize Lesson

Take the Extend Lesson

Take the Reuse Lesson 

57
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Within Edge Animate you can take In-App Lessons to help you get
started with the project. Edge Animate provides seven In App step-by
step lessons with the aid of the Lessons panel. The lessons include
Quick Start to help you get going, Create to teach you how to work with
shapes, text and images, Animate I: Keyframes and II: The Pin to show
you how to use keyframes and pins, Resize to learn how to respond to
size changes, Extend to learn how to loop and handle user interaction,
and Reuse to show you how to create reusable objects with symbols.
You can start an In App Lesson from the Welcome screen or the
Lessons panel. After you start a lesson, the Lessons panel walks you
through topic as you perform the steps in the Edge Animate window.

Starting a Lesson

Start a Lesson from the
Welcome Screen

Start Adobe Edge Animate, or
close all open documents (click
the File menu, and then click
Close All).

Click Getting Started, if necessary.

Point to a lesson tile to view a
brief description.

Click a lesson tile to start it.

The Welcome screen closes, Edge
Animate creates a new Untitled
project, and the Lessons panel
opens with the selected lesson.

Read and perform the lesson steps
in the Edge Animate window as
indicated in the Lessons panel.

At the bottom of the Lessons
panel, click the Next Step link.

Follow the additional steps or click
links to start other lessons. 

After you complete the lesson, you
can save or close the Untitled
project.

To close the Lessons panel, click
the Window menu, and then click
Lessons or click the Close button
on the panel.

8
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Start a Lesson from the Lessons
Panel

Click the Window menu, and then
click Lessons to select (show) the
check mark.

The Lessons panel opens,
displaying a list of In-App Lessons.

Click a lesson tile to start it.

Edge Animate creates a new
Untitled project, and the Lessons
panel displays the start of the
selected lesson.

Read and perform the lesson steps
in the Edge Animate window as
indicated in the Lessons panel.

At the bottom of the Lessons
panel, click the Next Step link.

Follow the additional steps or click
links to start other lessons. 

After you complete the lesson, you
can save or close the Untitled
project.

To close the Lessons panel, click
the Window menu, and then click
Lessons or click the Close button
on the panel.
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After you start a lesson, you use the Lessons panel to walk you through
the step by step instructions to complete the topic. If the Lessons panel
takes up too much room in the Edge Animate window, you can dock it to
another panel—the Properties panel is a good place to put it—or
undock it as a separate window. As you work through a lesson, you can
use the navigation at the top of the Lessons panel to get around. You
can use the Lessons button to display all the lessons or the navigation
buttons to switch between panels in the Lessons panel.

Using the Lessons
Panel

Use the Lessons Panel

Click the Window menu, and then
click Lessons to select (show) the
check mark.

The Lessons panel opens,
displaying a list of In-App Lessons.

Click a lesson tile to start it.

Edge Animate creates a new
Untitled project, and the Lessons
panel displays the start of the
selected lesson.

Follow the lesson steps in the
Edge Animate window, and then
click the Next Step link at the
bottom of the panel.

To go back and forth between the
Step panels, click the Previous or
Next button or click the Pane
Name list arrow, and then click a
pane name.

To display the list of lessons, click
the Lessons button.

To close the Lessons panel, click
the Window menu, and then click
Lessons or click the Close button
on the panel.

6
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With the Quick Start lesson, you can quickly create your first animation
in Edge Animate. It’s quick and easy, but it gives you simple way to see
how an animation works. You’ll create a rectangle on the Stage and
then use the Pin button and the Playhead in the Timeline to make the
shape move across the screen. After you create the animation, you’ll
play it back on the Stage and in the Timeline to see how it works.

Taking the Quick Start
Lesson

Take the Quick Start Lesson

From the Welcome screen under
Getting Started or the Lessons
panel, click the Quick Start lesson
tile to start it.

The Welcome screen closes, Edge
Animate creates a new Untitled
project, and the Lessons panel
displays the start of the lesson.

Select the Rectangle Tool on the
Tools panel.

Draw a rectangle in the upper-left
corner of the Stage.

Click the Pin button in the
Timeline.

Drag the Playhead to 0:01 
(1 second).

Move the rectangle to the lower-
right corner of the Stage.

Click the gray color chip (diamond)
in the Properties panel.

Click the Background Color box on
the Tools panel, and then select a
color from the palette.

Click the Play button or press
Space to play back the animation.

At the bottom of the Lessons
panel, click the Next Step link.

The lesson is complete.

Click the File menu, click Save,
navigate to a folder, create a
folder, enter a name for the
composition, and then click Save.
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With the Create lesson, you’ll learn how to quickly draw and work with
assets in Edge Animate. An asset is any artwork or element, such as
shapes, images, buttons, and fonts, you have created or imported into
your composition. In this lesson, you start from a sample file, and then
use it to work create and work with elements. You’ll create a rounded
rectangle, add text, add graphics from the Library panel, and organize
elements in the Elements panel. 

Taking the Create
Lesson

Take the Create Lesson

From the Welcome screen under
Getting Started or the Lessons
panel, click the Create lesson tile
to start it.

The Welcome screen closes, Edge
Animate creates a new Untitled
project, and the Lessons panel
displays the start of the lesson.

Click the Click to open the sample
link.

The content_creation.html file
opens, displaying a blank Stage.

Click the Next Step link to create
content (Step 2 of 5).

Select the Rounded Rectangle
Tool on the Tools panel.

Draw a rounded rectangle in the
center of the Stage.

In the Properties panel, click on
the link between W and H, and
then set the size of W to 220 and H
to 130. 

Click the Next Step link to add text
(Step 3 of 5).

Click the Text Tool on the Tools
panel.

Click in the center of the rectangle
and type Hello World.

Click the Close button in the Text
editor.

Continue Next Page
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Select the text, and then drag to
center the text in the shape.

As you drag towards the center,
Smart Guides (horizontal and
vertical) appear to indicate the
center. 

Click the Next Step link to import
graphics (Step 4 of 5).

Drag the background.jpg icon from
the Library pane onto the Stage
and place it at 0,0 (the upper-left
corner of the Stage). As you drag,
the position appears on the Stage.

The background image covers all
the other elements on the Stage.

In the Elements panel, drag the
background.jpg <div> element
below the RoundRect <div>
element. As you drag a black bar
appears indicating the new
location.

The background image moves to
the back of the Stage.

Click the Next Step link to organize
elements (Step 5 of 5).

In the Elements panel, drag the
Text <div> element onto the
RoundRect <div> element. As you
drag on top, the destination
element changes to gray.

The Text element is now
associated with the Rounded
Rectangle element.

The lesson is complete.

Click the File menu, click Save As,
navigate to a folder, create a
folder, enter a name for the
composition, and then click Save.

To open a finished version of the
lesson, click the Click to open the
finished sample link.
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With the Animate I: Keyframes lesson, you can create an animation by
setting keyframes at specific times on the Timeline and changing prop-
erty values between them. The property changes from one keyframe to
another over time on the Timeline creates animation. As an indicator,
when a keyframe is hollow, it means that it has different value than the
previous keyframe. Using keyframes is a little more time consuming,
however, you have more control over the results. To help make it easier,
you can use Auto Keyframe Mode, which automatically creates
keyframes when a property is modified, and Auto Transition Mode,
which automatically creates a transition as needed.

Taking the Animate
with Keyframes
Lesson

Take the Animate with
Keyframes Lesson

From the Welcome screen under
Getting Started or the Lessons
panel, click the Animate I:
Keyframes lesson tile to start it.

The Welcome screen closes, Edge
Animate creates a new Untitled
project, and the Lessons panel
displays the start of the lesson.

Click the Click to open the sample
link.

The keyframe_animation.html file
opens, displaying a blank Stage.

Click the Next Step link to create
keyframes (Step 2 of 7).

Move the Playhead to 0:01.

Select the E element on the Stage.

In the Properties panel, click the Y
keyframe (diamond) to add a
keyframe on the Timeline.

Move the Playhead to 0:00.

In the Properties panel, click the Y
keyframe again.

Change the Y value to -90.

Click the Play button or press
Space to play back the animation.

The E letter jumps to its position.
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Click the Next Step link to add a
transition (Step 3 of 7).

When two keyframes have
different values, you can add a
transition between the two values.

Right-click (Win) or Control-click
(Mac) either of the keyframes, and
then click Create Transition.

A transition appears connecting
the keyframes in the Timeline.

Click the Play button or press
Space to play back the animation.

The E letter smoothly transitions to
its position.

Click the Next Step link to specify
easing for the transition (Step 4 
of 7).

Click the transition in the Timeline
to select it.

Click the Easing button in the
Timeline, select Ease Out, select
Bounce, and then press Enter
(Win) or Return (Mac).

Click the Play button or press
Space to play back the animation.

The E letter falls and lands with a
bounce to its position.

Click the Next Step link to animate
the shadow element (Step 5 of 7).

Click the Auto Keyframe Mode
button in the Timeline to select it.

This automatically creates
keyframes when a property is
modified.

Click the Auto Transition Mode
button in the Timeline to select it.

This automatically adds a
transition when a property is
modified.

Continue Next Page
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Continue from Previous Page

Select the shadow element on the
Stage.

Move the Playhead to 0:01.

In the Properties panel under
Transform, click the Scale X and
Scale Y keyframe.

Move the Playhead to 0:00.

In the Properties panel under
Transform, set the Scale X value
to 0. Since the X and Y are linked,
both values change.

This creates an automatic
animation and transition using the
current one (Bounce).

Click the Play button or press
Space to play back the animation.

The shadow animates along with
the E element.

Click the Next Step link to reuse
keyframes (Step 6 of 7).

Select the E element on the 
Stage.

Click the Time Snapping button in
the Timeline to deselect it.

Move the Playhead to where the E
first hits bottom, around 0.364.

In the Properties panel, click the
Rotation keyframe.

Move the Playhead to where the E
reaches the top of the bounce,
around 0.544.

In the Properties panel, set the
Rotate value to -10.

Move the Playhead to where the E
hits bottom again, around 0.729.

Select the first rotation keyframe,
making sure that only the one
keyframe is selected.
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Press Ctrl+C (Win) or A+C (Mac)
to copy the keyframe, and then
press Ctrl+V (Win) or A+V (Mac)
to paste it.

Click the Next Step link to reuse
transitions (Step 7 of 7).

Click the Time Snapping button in
the Timeline to select it.

In the Elements panel, click the
gray dot under Visibility for G, D,
and E2 to display them on the
Stage.

In the Timeline, select the bar on
top of the transitions for the E
animation to select all transitions.

Press Ctrl+C (Win) or A+C (Mac)
to copy it.

Select the G element on the Stage,
move the Playhead to 0:01, and
then press press Ctrl+V (Win) or
A+V (Mac) to paste it.

Select the D element on the Stage,
and then press press Ctrl+V (Win)
or A+V (Mac) to paste it.

Select the E2 element on the
Stage, and then press press Ctrl+V
(Win) or A+V (Mac) to paste it.

Click the Play button or press
Space to play back the animation.

Each letter bounces in, one after
the other..
The lesson is complete.

Click the File menu, click Save As,
navigate to a folder, create a
folder, enter a name for the
composition, and then click Save.

To open a finished version of the
lesson, click the Click to open the
finished sample link.
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With the Animate II: The Pin lesson, you can quickly create an animation
by using the Pin to help you create keyframes. You’ll learn how to work
with the Playhead and the Pin to create an animation region. You’ll use
the completed file from the Create lesson (Hello World) and then add an
entrance and exit animation to it. 

Taking the Animate
with the Pin Lesson

Take the Animate with the Pin
Lesson

From the Welcome screen under
Getting Started or the Lessons
panel, click the Animate II: The Pin
lesson tile to start it.

The Welcome screen closes, Edge
Animate creates a new Untitled
project, and the Lessons panel
displays the start of the lesson.

Click the Click to open the sample
link.

The animation_start.html file
opens, displaying Hello World.

Click the Next Step link to add
easing (Step 2 of 5).

Click the Easing button in the
Timeline, select Ease Out, select
Quad, and then press Enter (Win)
or Return (Mac).

Click the Next Step link to add an
entrance animation (Step 3 of 5).

Move the Playhead to 0:00.250
(0.25 seconds).

Double-click the Playhead to
display a blue pin on top.

Drag the Pin (blue) to 0:00.750 
(0.75 seconds). This displays a 
blue region for the animation.

In the Elements panel, select the
RoundRec <div> element.

Shift-drag the shape element off
the Stage to the left.

In the Properties pane, set the
Rotate value to 720, and then click
the Stage.
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Click the Next Step link to add an
entrance animation (Step 4 of 5).

Drag the left Rotate keyframe right
to 0:00.500 (0.5 seconds).

Press Enter (Win) or Return (Mac)
to activate the blue region.

Drag the blue region right to
0:00.750 (0.75 seconds).

Select the Hello World text
element on the Stage.

In the Properties panel, set the
Scale X or Y value to 0, and set the
Opacity value to 0.

Click the Next Step link to add an
exit animation (Step 5 of 5).

Click the Easing button in the
Timeline, select Ease In, select
Quad, and then press Enter (Win)
or Return (Mac).

Drag the Pin (blue) to 0:01.75 
(1.75 seconds).

Drag the Playhead (gold) to
0:02.250 (2.25 seconds).

Select the Hello World text
element on the Stage.

In the Properties panel, set the
Opacity value to 0.

Drag the Yellow region to 0:00.500
(0.5 seconds) so the pin is at 0:02.

Select the RoundRect element on
the Stage, and then Shift-drag it
off the Stage to the right.

Click the Go to Start button, and
then click the Play button or press
Space to play back the animation.

The lesson is complete.

Click the File menu, click Save,
navigate to a folder, create a
folder, enter a name for the
composition, and then click Save.
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With the Resize lesson, you can create an animation that is responsive
to the size of the screen. For example, when you resize your browser
window, the composition resizes too. You can make the Stage and indi-
vidual elements responsive to the screen size by changing their units
from pixels (fixed) to percentage (adjustable). In addition, you can
change the relative change position to any corner of an element.
Instead of testing changes to your composition in your browser, you can
quickly check them on the Stage in Edge Animate.

Taking the Resize
Lesson

Take the Resize Lesson

From the Welcome screen under
Getting Started or the Lessons
panel, click the Resize lesson tile
to start it.

The Welcome screen closes, Edge
Animate creates a new Untitled
project, and the Lessons panel
displays the start of the lesson.

Click the Click to open the sample
link.

The resize_start.html file opens,
displaying an animation.

Click the File menu, and then click
Preview In Browser or press
Ctrl+Enter (Win) or A+Return
(Mac).

Resize the browser window to see
how it responds.

The animation doesn’t respond to
changes in the windows size.

Click the Close button to exit your
browser.

Click the Next Step link to % resize
the Stage (Step 2 of 8).

In the Elements panel, select the
Stage <div> element.

In the Properties panel, point to
the units for W, and then change
from pixels (px) to percentage (%).

Click the File menu, and then click
Preview In Browser or press
Ctrl+Enter (Win) or A+Return
(Mac).
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Resize the browser window to see
how it responds, and then click the
Close button to exit.

The Stage fills the width of the
browser with its light blue
background to the right of the
animation.

Click the Next Step link to % resize
on the Stage (Step 3 of 8).

Move the Stage adjustment handle
on the top ruler back and forth to
preview, and then return it to its
original position at 800 px.

Click the Next Step link to % resize
object’s location on the Stage
(Step 4 of 8).

In the Elements panel, select the
Text1 <div> element.

Hold down Shift, and then select
the Text2 <div> element.

In the Properties panel, point to
the units for X, and then change
from pixels (px) to percentage (%).

Move the Stage adjustment handle
on the top ruler back and forth to
preview, and then return it to its
original position at 800 px.

The text boxes adjust as the Stage
is resized.

Click the Next Step link to resize
objects of the parents (Step 5 of 8).

In the Elements panel, select the
red_ribbon <div> element.

In the Properties panel, point to
the units for W, and then change
from pixels (px) to percentage (%).

Continue Next Page
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Continue from Previous Page

Move the Stage adjustment handle
on the top ruler back and forth to
preview, and then return it to its
original position at 800 px.

Click the Next Step link to resize
the relative position of objects
their parents (Step 6 of 8).

By default, objects are positions
relative to the upper-left corner of
their parent. You can change the
relative position to any corner
using the Coordinate Space Picker
in the Properties panel.

In the Elements panel, select the
panel_bg <div> element.

In the Properties panel, select the
Bottom Right square in the
Coordinate Space Picker.

Point to the units for W, and then
change from pixels (px) to
percentage (%).

In the Elements panel, select the
panel1 <div> element.

Hold down Shift, and then select
the panel3 <div> element.

This selects panel1, panel2, and
panel3.

In the Properties panel, select the
Bottom Right square in the
Coordinate Space Picker.

Point to the units for W, and then
change from pixels (px) to
percentage (%).

Move the Stage adjustment handle
on the top ruler back and forth to
preview, and then return it to its
original position at 800 px.

This keeps the blue panel and the
animated text relative to the right
side of the Stage.
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Click the Next Step link to apply
layout presets to objects (Step 7 
of 8).

In the Elements panel, select the
FremontCycles <div> element.

In the Properties panel, click the
Layout Presets button, click the
Center Background Image preset,
and then click Apply.

Move the Stage adjustment handle
on the top ruler back and forth to
preview, and then return it to its
original position at 800 px.

This makes the element resize on
both X and Y axis while keeping
the image centered.

Click the Next Step link to set
resize constraints of objects their
parents (Step 8 of 8).

In the Elements panel, select the
Stage <div> element.

In the Properties panel, set the
Min W value to 650 px.

Click Max W, and then deselect
None.

Set the Max W value to 1280 px.

Click the File menu, and then click
Preview In Browser or press
Ctrl+Enter (Win) or A+Return
(Mac).

Resize the browser window to see
how it responds, and then click the
Close button to exit.

This keeps the size range of the
composition between 650 px and
1280 px.

The lesson is complete.

Click the File menu, click Save,
navigate to a folder, create a
folder, enter a name for the
composition, and then click Save.
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With the Extend lesson, you can code to your composition to extend the
functionality of your animation. With the code you can add interactivity
to animation. For example, you can add code to start an animation when
you click a button. When you click the button, it triggers an event to take
place. With Edge Animate, you don’t have to be a programmer to add
interactivity. It comes with Code snippets, segments of code, that you
can quickly insert to perform a task.

Taking the Extend
Lesson

Take the Extend Lesson

From the Welcome screen under
Getting Started or the Lessons
panel, click the Extend lesson tile
to start it.

The Welcome screen closes, Edge
Animate creates a new Untitled
project, and the Lessons panel
displays the start of the lesson.

Click the Click to open the sample
link.

The interactivity_start.html file
opens, displaying an animation.

Click the File menu, and then click
Preview In Browser or press
Ctrl+Enter (Win) or A+Return
(Mac).

The animation plays in your
browser.

Click the Close button to exit your
browser.

Click the Next Step link to add a
trigger (Step 2 of 7).

Move the Playhead to 0:00 in the
Timeline.

Click the Timeline menu, and then
click Insert Trigger or press Ctrl+T
(Win) or A+T (Mac).

In the Snippets list, click the Stop
button.

Click the Close button to exit.

Click the Next Step link to add an
action (Step 3 of 7).
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In the Elements panel, click the
Open Actions button for the play
<div> element.

Select click from the menu.

In the Snippets list, click the Play
button.

Click the Close button to exit.

Click the Next Step link to add a
label on the Timeline (Step 4 of 7).

Move the Playhead to 0:00.500 
(0.5 seconds).

Click the Timeline menu, and then
click Insert Label or press Ctrl+L
(Win) or A+L (Mac).

Type Loop for the label, and then
press Enter (Win) or Return (Mac).

Click the Next Step link to add a
timeline action (Step 5 of 7).

In the Timeline, click the Timeline
Actions button to the left of the
Actions row.

Select complete from the menu.

In the Snippets list, click the Play
button.

Replace 1000 with loop.

Click the Close button to exit.

Click the File menu, and then click
Preview In Browser or press
Ctrl+Enter (Win) or A+Return
(Mac).

Click the Play button to start the
animation in your browser, and
then click the Close button to exit.

Click the Next Step link to open
the Code window (Step 6 of 7).

Continue Next Page
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Continue from Previous Page

Click the Window menu, and then
click Code.

The Code panel opens in a
separate window.

Click the Next Step link to create a
loop counter (Step 7 of 7).

In the tree, select play.click.

Click to place the insertion point
below the code: sym.play();

Click the Code Snippets button to
display the Snippets panel.

Click Set Symbol Variable from the
Snippets list.

Modify the code to the following:
sym.setVariable(“count”,1);

This stores a value that you’ll use
to count the number of loops.

In the tree, select
Timeline.complete.

Click to place the insertion point
before the code: sym.play(loop);

Click Get Symbol Variable from the
Snippets list.

Modify the code to the following:
var count =sym.getVariable
(“count”);

Click to place the insertion point on
the line after the code: var count
=sym.getVariable (“count”);

Click Set Symbol Variable from the
Snippets list.

Modify the code to the following:
sym.setVariable (“count”, 
count + 1);
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Move the Playhead to 0:00.500 in the
Timeline.

Click the Timeline menu, and then
click Insert Trigger or press Ctrl+T
(Win) or A+T (Mac).

In the Snippets list, click the Get
Symbol Variable button.

Modify the code to the following:
var count = sym.getVariable
(“count”);

This displays the count.

Click to place the insertion point on
the line after the code:
sym.getVariable (“count”);

Click Set Element Text from the
Snippets list.

Set Element Text uses jQuery code
to modify the text of an element.

Modify the code to the following:
sym.$(“Text”).html(“” + count);

Click the Close button to exit.

Click the File menu, and then click
Preview In Browser or press
Ctrl+Enter (Win) or A+Return
(Mac).

Click the Play button to start the
animation in your browser. 

The animation continue to count
until you close your browser.

Click the Close button to exit.

The lesson is complete.

Click the File menu, click Save,
navigate to a folder, create a folder,
enter a name for the composition,
and then click Save.
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With the Reuse lesson, you can create symbols of an element so that
you can reuse it multiple times in you composition. When you import an
asset as a symbol or convert an existing element to a symbol, it’s known
as a definition. When you use the symbol definition in your animation, it
becomes an instance, which you can uniquely modify. You can add mul-
tiple instances of the same symbol and animate them differently. By
using the same symbol definition, you’re only using the asset once,
which reduces time it takes to load it.

Taking the Reuse
Lesson

Take the Reuse Lesson

From the Welcome screen under
Getting Started or the Lessons
panel, click the Reuse lesson tile
to start it.

The Welcome screen closes, Edge
Animate creates a new Untitled
project, and the Lessons panel
displays the start of the lesson.

Click the Click to open the sample
link.

The interactivity_start.html file
opens, displaying an animation.

Click the File menu, and then click
Preview In Browser or press
Ctrl+Enter (Win) or A+Return
(Mac).

The animation plays in your
browser.

Click the Close button to exit your
browser.

Click the Next Step link to convert
an object to a symbol (Step 2 of 5).

Move the Playhead to 0:01 
(1 second).

In the Elements panel, select the
SpinRect <div> element.

Click the Modify menu, and then
click Convert to Symbol.

Type Spin, and then click OK.

This creates a symbol, which you
can reuse. These are known as
instances.
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Click the Next Step link to create
instances of a symbol (Step 3 of 5).

In the Library panel, drag the Spin
icon from Symbols to the right of
the first instance.

Alt-drag the second instance on
the Stage to create another copy
to the right of it.

Click the Next Step link to convert
an object to a symbol (Step 4 of 5).

Double-click one of the instances
on the Stage.

The symbol opens to in-place
symbol editing mode.

In the Properties panel, deselect
the Autoplay check box, so the
symbol doesn’t play automatically.

In the Timeline, click the Timeline
Actions button to the left of the
Actions row.

Select complete from the menu.

To loop, click the Play from button
in the Snippets list.

Change the time of 1000 to 0. The
time is in milliseconds.

Click the Close button to exit.

In the Elements panel, click the
Open Actions button for the Center
<div> element.

Select click from the menu.

Add the code from the illustration.

Click the Close button to exit.

Click Back button or Stage on the
Edit bar to exit symbol editing
mode.

Continue Next Page
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Continue from Previous Page

Move the Playhead to 0:00 
(0 seconds).

In the Timeline, click the Add
button (+) in the Playback row for
the Spin element.

Click Play from the menu.

Move the Playhead to 0:00.750
(0.75 seconds).

Click the Add button (+) in the
Playback row for the Spin2
element, and then click Play.

Move the Playhead to 0:01.500 
(1.5 seconds).

Click the Add button (+) in the
Playback row for the Spin3
element, and then click Play.

Click the File menu, and then click
Preview In Browser or press
Ctrl+Enter (Win) or A+Return
(Mac).

Click the Close button to exit.

The lesson is complete.

Click the File menu, click Save,
navigate to a folder, create a
folder, enter a name for the
composition, and then click Save.
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Index

A
access Edge Services, 283
accessibility for people with disabilities, 120
accessing

nested symbols, 213
online help, 205
action

attaching to HTML element, 44
deleting, 199
editing, 199
for touch-based tablets or mobile

devices, 200
invoking a script with, 44

Actions icon in Elements panel, 36
ActionScript 3.0 to create animated GIF, 276
ActionScript, 2
add

animation to an HTML document, 258
CSS to JavaScript, 254
font, 132
graphics, 86, 87
HTML to JavaScript, 250
keyframe, 43
links to text, 140

Add Code button, 45
Add Keyframe diamond, 176-177
Add Web Fonts button, 133
address, text tag, 95
adjust

animation size automatically, 186
individual corners, 103
time in an animation, 184

Adobe Cloud, accessing, 266
Adobe ID for online publications, 266
Adobe programs, See After Effects, AIR,

Dreamweaver, Digital Publishing
Suite, Edge Animate, Fireworks,

Flash, Illustrator, InDesign, Muse,
Photoshop

Adobe tools and services, See Application
Manager, BrowserLab, Content
Viewer, Creative Cloud, Edge Code,
Edge Inspect, Edge Reflow, Edge
Runtime, Edge Web Fonts, PhoneGap
Build, Product Improvement Program,
Setup wizard, Typekit 

Adobe TV via Welcome screen, 57
Adobe TV, links to, 6
advanced animation, 22
After Effects, 1
AIR (Flash Platform), 2, 230
Align commands on Modify menu, 162
align

elements to each other, 163
elements with Smart Guides, 162

alignment guides, 88, 90, 122
Alternate Layout, create or delete in

InDesign, 265
AN file extension, 5, 14, 242
Android, 281, 286-287
angle brackets (< >), 95

<html>, 248, 250
within code, 205

animate an instance of a symbol, 148
Animate Deployment Package option

(.oam), 223-225
using to publish a composition, 230

Animate I and II lessons, 6
Animate I: Keyframes lesson, 64-67
Animate II: The Pin lesson, 68-69
animate with keyframes, 64-67
animated

content, creating, 280
elements, filtering, 41, 181
elements, showing, 181
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animated GIF
create as custom preloader, 276
exporting, 238
save image in Adobe Fireworks, 270

animation
add interactivity to, 74
adding time into, 185
adding to an HTML document, 258
adjusting time in, 184
automatically resize, 186
building, 11
building, 12
create interactive, 193
create with a transition, 178
create with Auto-Keyframe Mode, 174
create with keyframes, example, 177
creating a new, 14
creating quickly with the Pin, 172
exporting from Adobe Flash, 276
fade effect, 98
getting samples, 15
import into iBooks Author, 233
make resizable example, 188-189
making adjustments to, 182
open existing, 16
open in Adobe Dreamweaver, 260
planning, 10
playing, 180
preview with DPS and Adobe Content

Viewer, 267
previewing and testing, 13
previewing in browser, 19
publishing, 11, 13
publishing, 223-224
saving a, 20
testing a resizable, 190-191
three ways to create, 171
understanding, 2
work with HTML in Dreamweaver, 261
work with in Timeline panel, 183

animation region, creating a, 68
anti-alias option in Illustrator, 272-273
API (Application Programming Interface),

246
app, download Apple iBooks Author, 233
Apple iBooks Author, 232

publishing for, 224-225

Apple iOS, 281, 286-287
Apple Safari See Safari
Application Manager, 284
apply external CSS to element IDs or class-

es, 255
Arrange commands on Modify menu, 164
arrange elements in stacking order, 164
article, new tag in HTML5, 95
artwork

export as PNG image from Illustrator,
272

save as SVG from Illustrator, 274-275
asset, defined, 62

in Library panel, 38-39, 85
asterisk (*) after file name, 20, 24
attach

action script to element, 198
event to the Stage or Timeline, 200-201

attribute style, applying CSS using HTML,
252

attributes
change in Properties panel, 35
of HTML elements, 249
of shapes, 88
of text elements, 122

audience, defining, 10
authoring environment, 25
auto keyframes, create, 42-43
Auto-Keyframe animation example, 175
Auto-Keyframe Mode, 64-65, 172
Auto-Keyframes Mode button, 174-177, 216
automatically

assigned names for elements, 169
create keyframes, 174
resize animation, 186

Autoplay option, 234
Autoplay timeline check box, 144, 152
Autoplay, 29
Auto-Transition Mode button, 174-178, 216
Auto-Transition Mode, 64-65,172, 178
auto-transitions, create, 42-43

B
background color

for stage, 29
of shapes, changing, 106
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background image, centering, 73
backward slash (\) in JavaScript code, 204
bitmap graphics, 81

scaling, 85
understanding, 82

blank composition, create new, 14
blockquote, 95, 139
Blur value

for text, 138
of shadows, 107

body of an HTML tag, 248
Bonjour, set up, 286
border

color of shapes, changing, 105
size of shapes, changing, 104

Border Radius button, 102
Border Style list, 104
Border Thickness value, 104
bounding box, 100

image position in, 109
break up a group into individual elements,

166
Bring Forward, 164
Bring to Front, 164
BrowserLab, 19
browsers, create display for, 29
Build and publish phase, 9
Business Catalyst, using with Muse, 262
button, attach action script to, 198

C
Capture Poster Image button, 234
carpal tunnel syndrome, reducing, 52
case sensitive JavaScript, 204
CDN (Content Delivery Network), 224, 226

publishing to the web using, 228
Center Background Image, 73, 101
change

element
adjustability, 101
clipping, 118-119
corners with Transform Tool, 103
display, 96
opacity, 98
overflow, 97

position, 99
size, 100
tags, 95

language, 54
properties

in the Down-level Stage, 237
in the Preloader Stage, 239

shape
background color, 106
border color, 105
border size and style, 104
corners, 102

Stage properties, 28-29
text

properties, 128-129
tags, 139

Change Image Source button, 109
changes, undoing, 55
Character accessory in Mac, 126
check mark on menu, 26
Choose Poster Image button, 232
Chrome, Google

creating motion content to run on, 281
extension, 286
Frame plug-in, 226-227
get, 237
reading HTML documents, 249
synchronize browsing in, 3, 286
view animation in, 223

Chrome Frame Installer, 227
Class button, 94, 255
class name, 94 See also HTML and CSS
clear Open Recent list, 17
Click event action script, 193

attach to button, 198
Clip Background Image, 101
clip, remove, 119
Clipboard, placing elements on, 154
clipping area, 118
clipping text, 135
Clipping Tool, 32, 118-119, 135
close a composition, 24
CMS (Content Management Services)

frameworks, 2 
in Dreamweaver, 260
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code
add and edit with Adobe Edge Code, 254
change font size in script panel, 197
content, view and work with in Edge

Code, 280
edit, 3
font size, changing, 44
line numbers, show or hide, 44, 197

Code panel, 25-27
opening, 202
use to edit JavaScript, 244
using, 44-45

Code Snippets button, 45, 76
code snippets, 193 

accessing in a script panel, 203
inserting, 202
list, 203
to add links, 140
working with, 45

code statements, 207
Color for background and border, 33
color, 11

changing, 35
command, defined, 26
comments, working with when inserting

snippets, 204
Community Forum, 22-23

via Welcome screen, 57
links to, 6

compatibility of web browser, 227
composition files, extensions for, 21
Composition ID, 29
composition, 12

closing, 24
creating a new, 14
creating from scratch, 1
delete elements from, 156-157
open existing, 16
publishing, 225-226
putting in an HTML document, 256-257
saving vs. publishing, 224
saving, 20

composition, animation
add interactivity to, 74
adding time into, 185
adding to an HTML document, 258
adjusting time in, 184

automatically resize, 186
building, 11
building, 12
create interactive, 193
create with a transition, 178
create with Auto-Keyframe Mode, 174
create with keyframes, example, 177
creating a new, 14
creating quickly with the Pin, 172
exporting from Adobe Flash, 276
fade effect, 98
getting samples, 15
import into iBooks Author, 233
make resizable example, 188-189
making adjustments to, 182
open existing, 16
open in Adobe Dreamweaver, 260
planning, 10
playing, 180
preview with DPS and Adobe Content

Viewer, 267
previewing and testing, 13
previewing in browser, 19
publishing, 11, 13
publishing, 223-224
saving a, 20
testing a resizable, 190-191
three ways to create, 171
understanding, 2
work with HTML in Dreamweaver, 261
work with in Timeline panel, 183

compound, defining formatting for tags,
253

compressing graphics, 12, 81, 84
compression

method, selecting in Illustrator, 272-273
lossless and lossy, 84

Constrain Horizontal or Vertical, 111
Constrain/Unconstrain, 100, 109, 134
content

developing, 10
order of in Timeline, 180

Content Viewer, preview animation with,
267

contiguous (sequential order), 93
convert an element to a symbol, 144
Convert Guide to Percentage, 161
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Convert Guide to Pixels, 161
Convert to Symbol command, 78, 152
Convert to Symbol on Modify Menu, 216
Coordinate Space Picker, 101
copy and paste a trigger, 197
copying elements, 154
copyright rules, 83
Corner Radius button, 102
corners

adjust individual, 89
change element, 103

CPU (central processing unit), 11
create

animation with keyframes, example, 177
animations, three ways to, 171
CSS styles, 252
Down-level Stage, 236
instance from a symbol, 147
interactive animations, 193
interactive content with DPS, 266
label in the Timeline, 194
multi-touch book for iPad tablets, 232
new animation, 14
payment buttons for website, 218
Preloader Stage, 238 See also Flash
project folder, 9
project plan, 10
resizable animation, 186, 188
rollover button, 216-217
symbol, 214
symbols, 144
text boxes, 122

Create Button command, 218
Create lesson, 6, 62-63
Create New link, 6, 14
Create Symbol snippet, 212, 214
Creative Cloud services, 3, 281-282, 284

access samples from, 15
crosshatch pattern on the Stage, 96
CSS (Cascading Style Sheet), 34

add to JavaScript, 254
code, 95

editing, 244
using, 205 

create external files, 254
edit with Dreamweaver, 260

getting to know, 252
layouts, 2
preview, 3
programming for Edge Code, 280
style

applying to multiple elements, 94
using ID to apply, 94

tag styles, 252-253
text properties, 121, 127-128
vs. HTML, 252
working with, 254

CSS3 code, working with, 241
curly brackets ({ }) 

adding multiple attributes with, 205
in CSS, 252

cursor
changing when it hovers over a button,

216
over elements, changing, 108

Cursor button, 108, 140, 210, 216-217, 219
custom workspaces, 25

creating, 50
cut and paste elements, 154

D
dash displayed on Properties panel, 34, 92
Dashboard Widget (.wdgt), 224-225
declaration blocks in CSS, 252
default workspace, 25
Define phase, 9
define

element with an HTML tag, 95
purpose and audience, 10

definition, symbol known as, 144
delete

action, 199
elements, 156-157
label, 195
poster image, 235
symbols, 145
trigger, 197
web font, 133

Delete Symbol snippet, 212, 214
using, 215

Deployment Package (.oam), 13
Design phase, 9
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design, developing, 10
desktop browsers

create animations for, 227
create motion content to run on, 281

determine HTML5 browser compatibility,
244

develop
content and structure, 10
layout and design, 10

devices
inspecting web designs, 286-287
update, 3

diamond
representing keyframe, 34
Add Keyframe in Properties panel, 176

dictating text, 125
Digital Publishing Suite (DPS), 230, 264

publish a composition for use with, 230
publish animation in, 223-225
working with, 266

dimension markers, 90
disable a feature, 26
display

elements in Timeline panel, 41
tooltip, 178

Display property, 96
distribute elements, 163
Distribution commands on Modify menu,

162-163
DIV tags, defining elements with, 95
division tag (DIV), 250
dock a panel, 48
dock, adding icon to, on Macintosh, 5
Document Object Model (DOM), 247
Document tab arrow, 8

to switch files, 18
documents, create new via Welcome

screen, 4
dollar sign ($), jQuery selector, 204 
dot (.), separator in code, 204
Down-level Stage See also preloader 

change properties, 237
creating, 236
defining optional use of, 223-225
edit, 234

download
DPS tools, 266 

Edge Animate, 281-282
Edge Tools, 281, 283-284
iBooks Author app, 233
sample animations, 15

DPS, accessing, 266
drawing

shapes, 88
tools, 88

Dreamweaver, 1-2
modify source code with, 244
open animations in, 260
transferring files to web server with, 13
work with HTML for an animation in, 261

Drop Shadow button, 107
duplicating elements, 154-155
dynamic media, 12

E
Easing button, 43, 69, 178
easy access links via Welcome screen, 4
Edge Animate

about, 1, 280
AN files, 16

examining, 242
open from Windows or the Finder, 17
saving, 224

application icon, 5
Community Forum, 22-23
composition files, 21
download, 282
exit, 24
exploring, 3
find version number, 4
folder, 5
Help, 22
installing, 279, 284
introduction, 1
JavaScript API, 22-23
launching, 5
prepare system for, 280
starting in Macintosh, 5
starting in Windows, 4
using with browsers and mobile devices,

1
what you can do with, 2
window, 25-26
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viewing, 8
Edge Animate Runtime, 241

DOM elements in, 247
in head section of HTML code, 260

Edge Code
about, 3, 280 
add HTML links to text with, 141
copy and paste HTML code with, 256
downloading, 245, 283
installing, 284
HTML editor, 132
modify source code with, 244-245 

Edge Inspect, 1
about, 3, 280
Chrome extension, 286
downloading, 283
installing, 284, 286-287

Edge Reflow, 3, 280
Edge Tools & Services, 1

download, 282
exploring, 3
installing, 279, 285
prepare system for, 280

Edge Web Fonts, 1, 121, 130, 132, 280, 283
about, 3

edge_includes folder, 242-243, 256
edit

action event, 198-199
code in Edge Code, 280
code snippet, 202
Down-level Stage, 234
symbol without Stage elements, 150
text, 123-124
trigger, 197

Edit Symbol command, 151
electronic Copyright Office (eCO), 83
elements

action events, 200
add accessibility, 120
adding shadows to, 107
adjustability, change, 101
aligning, 162-163
appearing in Timeline, 93
attaching action script to, 198
automatic names assigned to, 169 
class, apply CSS style to, 254-255

clipping, 118-119
copying or duplicating, 154
corners, change, 103
deleting, 156-157
display in Timeline panel, 41
display, changing, 96
grouping, 166
hiding and showing, 165
ID, apply CSS style to, 254-255
lock or unlock, 36, 41, 168
modifying instances, 212
naming, 94
origin, transform, 110-111
overflow, changing, 97
position, change, 99
positioning on Stage, 12
renaming, 169
render using HTML, 229
reparenting, 167
resizing, 90
rotating, 112
scaling, 116, 187
selecting, 92
sequencing in Timeline, 12
set adjustability, 187
show or hide, 36
size, change, 100
skewing in Properties panel, 114
snap to guides, 161
stacking, 164
tags, changing, 95
using guides with, 160
working with, 37, 143

Elements panel, 8, 25-27
arranging elements on, 164
inserting an action, 198
Lock column in, 168
saving text and shapes in, 32
using, 36
working with, 37

Ellipse tool, 32, 88-89, 91
embed

and play a YouTube video, 220
code for fonts, 130-131

Embed ICC Profile in Illustrator, 273
Embed option in Illustrator, 275
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enable a feature, 26
events, executing on the Stage or Timeline,

201
examine

Adobe Edge Animate Runtime, 246
Edge Animate files, 242
Edge Animate window, 26
import graphic formats, 84
JavaScript code in snippets, 204

example projects
Auto-Keyframe animation, 175
create animation with keyframes, 177
Pin method animation, 173
resizable animation, 188-189

exit Edge Animate, 24
export See also importing graphics

animated GIF from Flash, 277
artwork as JPEG image from Illustrator,

273
HTML file into Edge Animate, 271
symbol, 39, 146

Extend lesson, 6, 74-77
extension, locating for graphic, 87
external

CSS files, 254-255
style sheets in CSS, 252-253

Eye icon in Elements panel, 36, 165

F
Facebook icon, 6
fade animation effect, 98
Fade Element code, 207
FAQs on community forum, 23
feathering shadow edges, 138
federal regulations, 83
file

descriptions for Edge Animate, 243
extension, AN, 5
extensions, 21
extensions, showing or hiding in Mac

OS X, 5
open a recently opened, 17
open from Windows/File Explorer or

Finder, 17
opening, 5
path, locating for graphic, 87
type, identifying, 5

file and folder structure, 13
filtering animated elements, 41
finishing a composition, 24
Firefox

creating motion content to run on, 281
reading HTML documents, 249
viewing animation in, 223

Fireworks, 2
bitmap graphics in, 81
create graphics for Edge Animate, 1-2
exporting HTML document and images

rom, 271
save graphics from, 270

Flash Professional, 1- 2
export animated GIF from, 238, 277
exporting animations from, 276
technologies used, 276

flattened PNG, import into Edge Animate,
270

Flex, 2
Flip Playhead and the Pin, 173
flowchart sample, 11
folder location, creating, 20
Folio Overlays panel in DPS, create interac-

tive content with, 266
Folio Preview Settings in DPS, 267
Folio Producer tools, downloading, 266
Folio publication, create in Adobe InDesign,

264
fonts, 3, 11

browse commercial in Typekit, 280
characteristics, 127
family, 127-128
for web pages, 132 
resources, 121, 126

font, web
library, free from Adobe, 280
providers, 132
adding, 38, 121, 131-133
deleting, 39, 133
getting, 130-131

Fonts.com, 121, 130, 132
Fontsquirrel.com, 121, 130, 132
Format popup, Mac, 21
formatting

rules of web page (styles), 254
text, 128-129
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forum for Edge Animate users, 22-23
frame, undock, 49
Frameworks via CDN, 226, 228
FTP (File Transfer Protocol), 2, 13

in Dreamweaver, 260
Full Code button, 45
function command within code, 204
functionality, add to web page, 193

G
Get Element snippet, 208
Get Symbol snippet, 212-214
Get Symbol Variable snippet, 215
getting started, 6
GIF (Graphics Interchange Format)

about, 84
convert Photoshop document to, 268
create simple animated as custom pre-

loader, 276
export animation from Flash, 277
files, 232
importing, 85-87
in compositions, 1-2
save image in Adobe Fireworks, 270

Go To Asset, (locating OAM animation), 263
Go To Conflict command, 52-53
Google Chrome

creating motion content to run on, 281
extension, 286
Frame plug-in, 226-227
get, 237
reading HTML documents, 249
synchronize browsing in, 3, 286
view animation in, 223

Google web fonts, 131-133
graphics

adding, 86, 87
bitmap, 82
compressing, 12, 81, 84
extension, locating, 87
file path, locating, 87
ID name, 94
importing, 85
name, locating, 87
save from Adobe Fireworks, 270
using, 83

vector, 82
working with, 81

grey dot
in Elements panel, 168
in Timeline panel, 168
in Visibility column, 165

Grid Size button, 40
Group Elements in DIV command, 166
group elements, 37
group/ungroup elements, 166
guides

change type, 161
displaying, 159 
horizontal and vertical, 90
locking and unlocking on the Stage, 160
snap elements to, 161
view position, 161
working with, 160

H
h1-h6, HTML headings, 95
hardware requirements, 11
head of an HTML tag, 248
header bars on panels, 46
heading tags, 95
Help and Tutorials, 6 

via Welcome screen, 57
help for Edge Animate JavaScript API, 247
Help menu, 22-23

accessing, 205
Hex value or hex triplet, 105-106
hide and show

elements, 165
guides, 159
rulers, 158

Hide Element snippet, 206
hollow keyframes, 176, 178
HTML (Hyper Text Markup Language), 1-2,

241
adding to JavaScript, 250
attribute style, using to apply CSS, 252
edit with Dreamweaver, 260
publish content as static, 226, 229
understanding, 248-249
using to create URL links, 210-211
using, 205
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HTML (continued)
viewing and editing, 244
working with animation in

Dreamweaver, 261
working with, 241, 250-251 

HTML division (DIV) tags, 95, 139
HTML document

add animation to, 258
put a composition into an, 256-257

HTML editor, Edge Code, 132
HTML element, attaching action to, 44
HTML files

creating, 225
editing, 243
export into Edge Animate, 271
numbering, 14
opening multiple, 16
quickly close, 18
save in Adobe Fireworks, 270
saving, 224, 242
web page file, open, 16

HTML ID name, 250
HTML links, add to text, 141
HTML source code, viewing, 249
HTML tags

assigning to text, 139
defining elements with, 95
integrating in code, 208

HTML vs. CSS, 252
HTML5, 2

audio, 221
browser compatibility, determining, 244
in Dreamweaver, 260
pagination options, 265
technology in Edge Animate, 227, 241

I
iBooks Author

app, download, 233
publishing for, 232

iBooks/OS X
Dashboard Widget (.wdgt), 13
publishing a composition, 232
publishing option, 223-225

ID names within code, 205
Illustrator editing capabilities, preserving

for revisions, 275 
Illustrator

create graphics for Edge Animate, 1-2
export artwork as JPEG image, 273
export images from, 272
prepare vector graphics in, 81
save artwork from, 274-275

images
edit with Adobe Fireworks, 270
elements, modifying, 109
exporting from Adobe Illustrator, 272
locating, 39
position in bounding box, 109
resolution, specifying in Illustrator, 

272-273
saving from Adobe Photoshop, 268 
swapping in a photo gallery, 222

image, graphics
adding, 86, 87
bitmap, 82
compressing, 12, 81, 84
extension, locating, 87
file path, locating, 87
ID name, 94
importing, 85
name, locating, 87
save from Adobe Fireworks, 270
using, 83
vector, 82
working with, 81

img, graphic tag, 95
Import Symbols command, 145
imported OAM file, working with, 263
importing

animation in iBooks Author, 233
graphics, 85
into Adobe Muse, 262
package into Adobe InDesign CS6, 264
package into Adobe program, 231
symbols, 145

In-App lessons, panel
about, 6
starting, 58
topics, 57
using, 7
via Welcome screen, 4
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In-App lessons to take
Animate I and II, 6
Animate I: Keyframes, 64-67
Animate II: The Pin, 68-69
Create, 62-63
Extend, 74-77
Keyframes, 64-67
Quick Start, 61
Resize, 70-73
Reuse, 78-80

Include Snippet Comments, 197
incompatible web browsers, 234, 235
InDesign

publish a composition for use with, 230
importing into, 264
publish animation in, 223-225

indexing on the web, improving, 229
individual corners, adjusting, 103
information, getting detailed, 22
insert

code snippet, 202
action event, 198 
time in animation, 185

Insert Label button, 43, 194, 216
Insert Shadow button, 107
Insert Time command, 185
Insert Trigger button, 196, 202-203, 250, 254
install

Edge Animate, 284
Edge Inspect, 286-287
Edge Tools, 284-285

instance
adding multiple, 144
change properties of, 148-149
creating from symbol, 147
of a symbol, 143, 147
of element, modifying, 212

interaction, adding to an HTML document,
258

interactive
animations, create, 193
content, creating, 280

interactivity
add to animation, 74
adding, 12

interim versions of compositions, 20

interlaced images in Illustrator, 272
Internet Explorer

creating motion content to run on, 281
publishing to the web for, 227
reading HTML documents, 249
view animation in, 223

iPad and iPhone, create interactive docu-
ments for, 264

iPad tablets
creating multi-touch books for, 224
publishing to with DPS, 266

J
JavaScript API

get help for, 247
in Edge Animate, 246
website, 23

JavaScript, 193
add CSS to, 254
adding HTML to, 250
edit in Code panel, 244
edit with Dreamweaver, 260
examining in snippets, 204
example code for, 205
files, 1-2, 14 

(.js) files, saving, 224
creating, 225 
editing, 243

in Dreamweaver, 260
inserting, 202
libraries, 241
programming for Edge Code, 280
reference material, 6
reserved keywords in, 204
using to create symbols, 214
using to show and hide elements, 206
working with, 241

JPG/JPEG (Joint Photographic Experts
Group), 84-87

convert Photoshop document to, 268-269
export Illustrator artwork as, 273
file format for the web, 272-273
in compositions, 1-2
save image in Adobe Fireworks, 270

jQuery
about, 241, 243
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jQuery (continued)
documentation for, 242
library files, 228
selector within code, 204

JS extension, 193
JSON (JavaScript Object Notation), 2, 242-

243
jump between keyframes, 178

K
Key Features, 6
Keyboard Shortcut

changing a, 53
creating, 52
removing conflicts, 52-53

keyframes, 34
add manually, 176
create animation using, 171, 174, 176
deleting, 182
go to previous, 182
hollow, 176, 178
in Timeline, 42
lesson, animate with, 64-67
values, 178
working with in Timeline panel, 182

Kindle, 281, 286-287

L
label

insert in Timeline, 194
use to create a loop, 194
working with in Timeline, 195

languages, 281
changing, 54

launching Edge Animate, 5
layers

extending, 184
working with in Timeline panel, 182-184

layout defaults, setting, 33
Layout Preset button, 73, 101, 187
layout preset, applying, 101
layouts

create responsive in Edge Reflow, 280
developing, 10-11
leverage content for multiple, 264-265
split window to compare, 265

lessons
about In-App, 6
In-App, via Welcome screen, 4
starting a, 58-59
topics, 57
use an In-App, 7

Lessons panel, 6, 25-27
using, 60

lessons to take
Animate I and II, 6
Animate I: Keyframes, 64-67
Animate II: The Pin, 68-69
Create, 62-63
Extend, 74-77
Keyframes, 64-67
Quick Start, 61
Resize, 70-73
Reuse, 78-80

letter spacing, 127, 129
library of commercial web fonts, 121
Library panel, 8, 25-27

add graphic asset from, 87
assets in, 85
edit a symbol in, 150
using, 38-39

line height, 127, 129
line indent, 127, 129
Link option in Illustrator, 275 
links

add to text, 140
Create New, 6
Open File, 6
to target URL, 237

Liquid Layout options, applying, 264-265
List of Action Events, 200
listing of code snippets, 203
Live Code button, 261
Live Code view, 260 See HTML code
Live view, preview animation in, 260
locate

graphic file path, 87
graphic name, 87
graphic extension, 87

Lock Guide command on View menu, 160
Lock icon in Elements panel, 36, 168
lock or unlock
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elements, 41, 168
guides, 160

loping, 79
create using a label, 194
learn how to, 6

lossless compression, 84
lossy compression, 84

M
Mac App Store, 224, 232
Macintosh

OS X Lion and Mountain Lion, 5
starting in, 5
system requirements, 281

main folder, 9
manually

adding keyframes, 176
creating transition, 178-179

markup language, HTML, 248
media elements

assembling, 12
organizing, 36

menu, defined, 26
minimum system requirements, 281
mobile apps, build, 3, 280
mobile devices

create animations for web browsers on,
227

create interactive documents for, 264
preview web designs for, 286-287
using action events with, 200

modify elements, 37
Modify menu

Align commands on, 162-163
Arrange commands on, 164
Distribution commands on, 162
edit a symbol in, 150
Smart Guides on, 88-90

modifying image elements, 109
monitor resolution, 11
monospace fonts, 127
motion

animations, creating, 171
effects, adding, 12

move
label, 195

panel, 47
playhead, 42
trigger, 197

multiple actions, attach to an element, 198
multiple animations, working with, 18
multiple compositions, putting in HTML

document, 256-257
Muse, 230

importing into, 262
publish a composition for use with, 230
publish animation in, 223-225
work with animation in, 263

N
name

element IDs or classes, 94
locating for graphic, 87

navigation, 11 
options in Lessons panel, 60
adding, 12

nest a symbol within a symbol, 152
nested symbol

accessing, 213
working with, 153

New Folder button, 21, 146
new folder, creating a, 9
non-contiguous (not in sequential order), 93
non-HTML5 browsers, create display for, 29
Notification icon on the Stage, 30

O
OAM (Deployment Package)

files, creating, 225, 230-231
importing into InDesign document, 264
placing into an open Muse web site, 262
publish animation as,13
view imported, 263

one-step pin animations, 42
online help, accessing, 205
Only Show Animated Elements button, 93
Opacity property, 98
opacity, changing element, 98
open a URL with HTML code, 211
Open Actions button, 43, 140, 198-199, 203,

206-207, 209-215, 217, 219-220, 222,
250, 254
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open and close panels, 46
open Edge Animate composition in

Dreamweaver, 260
Open File link, 6
Open Recent list, clearing, 17
Open URL button, 140
Open URL snippet button, 203
Open URL snippet, 218

using, 210
optimizing graphics, 81
orange keyframes, 182
origin point of element, transform, 110-111
OS X Lion and Mountain Lion, 5
OS X Mountain Lion, dictating text with,

125
Overflow, 29

options in Properties panel, 97

P
p, tag for paragraph, 95
panels

defined, 27
docking and undocking, 48-49
working with, 46-47 

parent/child relationship in the Stage, 167
Paste Special submenu on Edit menu, 155
path, locating for graphic file, 87
PayPal

create shopping cart button, 219
get embed code for, 218

percentage, change to pixels, 70
percentage-based guides, 161
period (.), class names begin with, 253
phases

Build, 9
Define, 9
Design, 9
Structure, 9

PhoneGap Build, 2
about, 3, 280, 283
in Dreamweaver, 260

photo gallery, swapping images in, 222
Photoshop, 2

bitmap graphics in, 81
create graphics for Edge Animate, 1, 2
save an image in a web format, 268

saving images from, 268
Pin button, 61
Pin method

example, 173
to create animation, 171-173

pixel-based guides, 161
pixels

change to percentage, 70
defined, 82

play animation, 42, 180
Play From button, 79
Play/Pause button, 42
Playback Actions button, 149
Playback commands

modify an instance with, 149
set for instances, 148

Playhead
and the Pin, flip positions, 173
commands, 180
in Timeline panel, 42
learn to use, 61
working with, 180

PNG (Portable Network Graphic), 84, 85-87
convert Photoshop document to, 268-269
file for poster image, 234
file format for the web, 272
image, export Illustrator artwork as, 272
import files into Edge Animate, 270
in compositions, 1-2
save image in Adobe Fireworks, 270

pointing finger for URLs, 210
poster image, capture, 234
pound sign (#), ID names begin with, 253
pre, tag for preformatted text, 95
Preloader Stage, 29

change properties in, 239
create progress bar, 223-224
create simple animated GIF for, 276
creating, 238 
define optional use of, 225
export animated GIF from Flash, 277

prepare for project management, 9
preview an animation in a web page, 19
Preview in Browser command, 19, 70, 140,

190-191
Preview Mode button, 262
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Product Improvement Program, participat-
ing in, 22

product release notes, links to, 6
Professional ActionScript IDE, 2
programs See also Adobe programs

importing a package into, 231
publishing for, 224

progress bar
create in Preloader Stage, 238
creating, 223-224

project
building a, 12
folder, create, 9
management, 9
plan, 9-10
preparing for, 9

project, examples
Auto-Keyframe animation, 175
create animation with keyframes, 177
Pin method animation, 173
resizable animation, 188-189

Properties panel, 8, 25-28, 87-88
change attributes, 35
change element clipping in, 118-119
changing shape corners in, 102
coordinates in, 99
Image settings in, 109
inserting an action, 198
modify an instance, 148
Overflow options in, 97
pixels or percentage in, 100
scaling elements in, 116
Shadow header bar in, 107
skewing elements in, 114
transforming element origin point, 110-

111
using, 34

property group, collapse or expand, 41
Publish in Browser command, 13
Publish Settings command, 13, 225-227
publishing

a composition, 224-226
animations, 223-224
content as static HTML, 226
folder, 224-226
for Adobe programs, 230
for Apple iBooks/OS X, 232

to the web, as static HTML, 229
to the web, using Frameworks via CDN,

228
purpose, defining, 10
put a composition in an HTML document,

256-257

Q
Quick Start lesson, 6, 61
quit Edge Animate, 24

R
RAM (system memory), 11, 14
recent file, open quickly from Start menu,

17
Recent Files link, 6
recent items

open via Welcome screen, 4
recently saved version, reverting to, 21
Rectangle tool, 32, 88-89, 91
red line, indicating Timeline position, 180
Redo and Undo commands, 55
regulations, federal, 83
relative position of elements, 101
relink OAM file, 263
remote inspection of mobile devices, 286
Remove Clip command, 119, 135
remove poster image, 235
rename

composition, 21
element, 37, 169
label, 195
symbols, 145

reparent elements, 167
reset a workspace, 50
resizable animation

example, 188-189
testing, 190-191

resize
animation, 186
elements with Smart Guides, 91
handles, 92, 100
panels, 46-47
text box, 134

Resize lesson, 70-73
resolution, selecting in Illustrator, 272-273
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resource links on Welcome screen, 57
resources, 6

finding, 22
responsive layouts, create, 3
restore a panel, 47
reusable objects and symbols, learn how to

create, 6
Reuse lesson, 6, 78-80
reusing elements, 143-144
revert to recently saved version, 21
RGB color, 105-106

selecting, 35
Rich Internet Applications (RIAs), 2
rollover button, creating, 216-217
Rotate value in degrees, 112
rotate, 110, 112-113, 136-137
Rounded Rectangle Tool, 32, 62, 88-89, 91
rulers 

adjustment handle (pin), 101
and guides, using to place elements, 143
displaying, 158
on the Stage, 30

Runtime
about, 241
DOM elements within, 247
examining, 246
libraries, 228

S
Safari

creating motion content to run on, 281
reading HTML documents, 249
view animation in, 223

sample
animations, download, 15
click link to open, 70, 78
projects via Welcome screen, 57
projects, links to, 6

sans serif fonts, 127
Save As Type list arrow (Win), 21
Save vs. Save As, 21
saving

animation, 20
composition, 224

Scale Background Image, 101
scale elements, 187

Scale Position, 101
preset, 188

Scale Size, 101
Scale X and Scale Y keyframes, 66
scale, 110, 116-117, 136-137
screenshots, capture, 3
script panels, 193

working with code, 197
scripting, 12, 13
scroll bars on the Stage, 30
Scrub check box, 149
scrubbing, 180 

across Timeline, 42
searchability on the web, improving, 229 
Section 508 rules, 83
select

label, 195
trigger, 197
elements, 37, 92

Select Image button, 237, 239
Selection Tool, 32, 91-94
semicolon (;), end of code statement, 204
Send Backward/Send to Back, 164
serif fonts, 127
set an element ID or Class, 255 See also

CSS
Set Element Text command, 209
Set Element Text snippet, 208-209
Set Symbol Variable snippet, 215
Set Symbol Variable, 76
Setup wizard, 279
Shadow header bar in Properties panel, 107
shadows

adding to elements, 107
adding to text, 138

shape elements, default settings, 104
shape tools, 32
shape, ID name, 94
shapes

attributes of, 88
changing background color, 106
create, 90
drawing, 88
working with, 81

shopping cart buttons, creating, 218
shortcut keys, 27
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shortcut, create on Macintosh, 5
show and hide

elements, 165
guides, 159
rulers, 158

Show Element snippet, 206
Show Grid button, 40
show/hide snippet comments, 204
size changes, learn how to respond to, 6
size of folder, reducing, 11
skew, 110, 114-115, 136-137
Slide Element code, 207
Smart Guides on Modify menu, 88-90, 100,

122
aligning elements with, 162
drawing shapes with, 91
resizing elements with, 91

snap elements to guides, 161
Snap To options in Timeline menu, 41
snippet comments

include or not, 197
including, 44

snippets, 13
changing text as part of action, 208-209
examining JavaScript code in, 204
open URL with, 140

social media, accessing, 6
software requirements, 11 
sound, adding to HTML, 221
sound hardware, 11
source code, view from web browser, 244,

249
special characters, inserting, 126
special commands, pasting, 155
Split button, 261
Spread value of shadows, 107
stack elements, 37, 164
Stage elements, edit symbol without, 150
Stage properties, 12

changing, 28-29
edit a symbol, 151
view, changing, 31

Stage, 8, 25-27
attaching an event to, 200-201
set properties, 30
working with, 30

Start Dictation command, 125
starting Edge Animate, 4
Static Background Image, 101
Stop snippet code, 196
storyboard and script sample, 11
straight HTML code, working with, 251
string data in JavaScript, 204
Structure phase, 9
structure, developing, 10
style types, 253
support, getting online, 22
supported graphics files, 81
SVG (Scalable Vector Graphics), 84, 85-87

in Illustrator, 274
in compositions, 1-2

SVG Code, viewing in browser, 275
SVN (Subversion), 2

in Dreamweaver, 260
swap an image in a photo gallery, 222
switch

between multiple animations, 18
to a workspace, 51

Symbol File format (.ansym), 145-146
symbols

creating an instance from, 147
creating, 144
defined, 143-144
definition, 78
definitions in compositions, 144
deleting, 145
duplicating, 152
editing, 150-151, 153
exporting and modifying, 39
importing, 145
in Library panel, 38-39
modifying an instance from, 148
nesting within a symbol, 152
renaming, 145
using JavaScript to access nested, 213
working with nested, 153
working with, 143

system
requirements for Windows and

Macintosh, 281
prepare for installation, 279
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T
tablet devices

create animations for web browsers on,
227

publishing to with DPS, 266
using action events with, 200

Tag Style method for CSS, 252-253
tags

common HTML, 248
defined, 95
redefining current style, 253
within HTML code, 205

test a resizable animation, 190-191
text, 11

align, 127
add HTML links to, 141
add links to, 140
adding, 123
box

add shadows to, 138
edit contents, 122-123
creating, 122
resizing, 134

clipping, 135 
creating, 90
editing, 124
elements, attributes, 122
inside angle brackets <html>, 248-249
properties

changing, 128-129
examining, 127

specific tags, 121
tags, changing, 139
transforming, 136

working with, 121
Text tool, 33

intro to, 121
Text_Animate <div>, 188
Time Snapping button, 66-67
time

adding to animation, 184
inserting in animation, 185

timecode, zoom in or out, 40
Timeline Actions button, 79
Timeline effects, built-in, 13

Timeline grid, 40
Timeline panel, 8, 25-27

display elements in, 41
inserting an action, 198
Lock column in, 168
using, 181
using, 40
work with controls, 42-43
working with animations, 183
working with keyframes, 182
working with labels in, 195
working with layers, 182-183

Timeline Snapping button, 41, 181
Timeline, 12, 171

attaching a trigger to, 196
attaching an event to, 200-201
commands, 180

Toggle Display of Code Snippets button,
202-203

Toggle Element code, 207
Toggle Pin button, 43, 174, 176-177
Tools & Services, installing, 279
Tools panel, 8, 25-27, 88

specify border color in, 104
Text Tool, 122
using, 32

tooltip, displaying, 178
transform origin point, 110-111
Transform Origin X or Y values, 110, 112,

114, 116-117
transform origin, 92
transform text boxes, 136-137
Transform Tool for text, 136-137
Transform Tool, 32, 89, 110-111

change element corners with, 103
rotating elements with, 112-113
scaling elements with, 117
skewing elements with, 115

transforming text, 121
transitions, 11

between keyframes, 178
create manually, 178-179
creating, 172
working with, 179

Transparent box, 35
Trigger panel, opening, 202
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triggers
inserting and editing in Timeline, 196
working with in Timeline, 197

troubleshooting
dictating text, 125
web page doesn’t open, 19

Twitter icon, 6
two forward slashes (//) in JavaScript, 204
Typekit, 121, 130, 132, 280, 283

about, 3
using with Muse, 262

types of styles, 253

U
U.S. Copyright Office, 83
Undo and Redo commands, 55
undock a frame or panel, 49
ungroup elements, 37, 166
unlock or lock

guides, 160
elements, 168

unparent elements with Ungroup, 167
unsaved Edge Animate composition, 20
update a device, 3
Update Asset (OAM file), 263
updates from Adobe, 279
URL

adding a link to an element, 210
open with HTML code, 211

use
Create Symbol snippet, 214
Get Element snippet, 208
Get Symbol snippets, 212

user interaction
handling, 6
learn how to handle, 6

using
Show and Hide Element snippets, 206
Code panel, 44
Elements panel, 36
Tools panel, 32

V
values

changing, 35

keyframe, 178
variables, working with when inserting

snippets, 204
vectors

based format graphics (SVG), 274
defined, 81
drawing tools, 81
graphics, 81-82
shapes, 88

video
embed and play YouTube, 220
hardware, 11

view
imported OAM file, 263
source code from a web browser, 244

View menu, 31
View scrub, 31

W
WDGT files, 233

importing, 232
creating, 225
publish animation as, 13

web browser
and markup tags, 249
displaying content in, 241
testing resizable animation in, 191
view animation in, 223
viewing HTML markup language, 249

Web Content Accessibility Guidelines
(WCAG), 83

web designs
preview for mobile devices, 280, 286-287
previewing, 3

web font
library, free from Adobe, 280
providers, 132
adding, 38, 121, 131-133
deleting, 39, 133
getting, 130-131

web graphics, 1-2
web pages

add functionality to, 193
use of heading tags by search engines,

95
web publishing options, 223-226
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web, publish composition for use on, 224
WebKit, 281
Welcome screen, 4

using, 6
whitespace, ignoring in JavaScript code,

204
window, viewing the Edge Animate, 8
Windows, system requirements, 281
wizard, Adobe Setup, 279
word spacing, 127, 129
working with

Alternate and Liquid Layouts, 265
animation in Muse, 263
comments and variables when inserting

snippets, 204
CSS, 254
Digital Publishing Suite (DPS), 266
HTML, 250-251

straight HTML code, 251
symbols and elements, 143
transitions, 179

workspaces
creating and using, 50
deleting, 51
switch to a, 51

Workspaces submenu, 50
World Wide Web Consortium (W3C), 83

X-Z
X and Y coordinates, 99
YouTube, embedding and playing videos,

220
Zoom in and out commands, 31
Zoom slider, 40
Zoom Timeline to Fit button, 40
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